M ethodology
Mobile API

Overview

There are two parts to the Mobile APIs, the end-to-end encryption method and the swipe device library.

End-to-End Encryption

The end-to-end encryption library allows credit card data to be encrypted on a mobile device before sending it
to the Merchant's back-end server. During the sale process, the Merchant's server can send the encrypted card
data to the Payment Gateway, where it is decrypted and treated like a normal credit card. This givesthe
merchant more control of mobile transactions without having to increase compliance costs.

The merchant's encryption key isan RSA public key that is unigue to them. This means that the encrypted credit
card datawill only be able to be used to make a transaction in that merchant's payment gateway account. Only
the Payment Gateway has access to the private key that corresponds to this public key.

Card data is encrypted using AES encryption with a new randomly generated key for every card. Thiskey is
then encrypted with the public key along with the card data. This packet (the encrypted card and AES key) is
unreadable to anybody without the private key which is only known to the Payment Gateway.

Note: The public key cannot be used to decrypt an encrypted card. Once encrypted, the card is unusable except
by the Gateway when it processes the payment for the merchant. For this reason, there is no need to keep the
public key a secret.

Swipe DeviceLibrary

This library supports the encrypted card readers supported by the payment gateway. Thisincludes parsing the
data and notifying you when a card reader is connected, disconnected, ready to receive a swipe, €tc.

Using theLibrary
Mobile API: Android

Creating a Project

The fastest way to get started is to check out the Client Encryption Example project that can be downloaded
from the downloads section. Or if you prefer to create your own project, use these steps:

These directions ar e specific to the Eclipse I DE.
1. Download and extract the zip file from the integration section of the Payment Gateway .



2. In eclipse, select File -> New -> Project.
3. Import the SDK
1. Right click on the libs directory in the new project, and select Import.
2. Select File System underneath General, and click next.
3. For thedirectory, click browse and inside of the extracted folder from before, select Payment
Gateway Mobile SDK.
4. Select al three Jar files and click finish.
4. Add SDK filesto build path.
1. Right click on the imported files and select Build Path -> Add to Build Path.
2. Right click on the project and select Build Path -> Configure Build Path...
3. Inthe Order and Export tab, select the SDK files.
4. Click OK.

Network Usage Note

Y ou may notice the library attempting to connect to IDTECH's website to download afile. Since the audio jack
capabilities of different Android devices vary, the IDTECH Shuttl€'s library uses different communication
settings for each supported device. IDTECH frequently updates alist of the supported devices and the
communication settings for each which the library may attempt to download from IDTECH. Internet permission
isrequired.

End-to-End Encryption
Mobile API: Android

Acquiring a Public Key

a
After logging into the Payment Gateway, navigate to Settings -> Security Keys-> View Mobile SDK

Key. You can click on the Java example button to get a version that can easily be copied and pasted into
your project.

Use the Query APIL. In order to get the public key, you will need to use 'report_type=sdk_key'. The key
will be returned in the &It;sdk_key& gt; tag.

Encrypting a Card

The following is an example of the entire encryption process:

i mport com Saf eWebSer vi ces. Paynent Gat eway. PGEncr ypt ;

PCGEncrypt pg = new PGEncrypt();

Pg. set Key(
"***999| M | EEj CCA3ugAW BAgl BADANBgk ghki G3wOBAQQFADCBV TEL MAK GA1UEBh"
" MCWMKETAPBgNVBAGTCEI sb@ ub2l z MVRMVEQYDVQQHEWP TY2hhdWLi dXJnMRgwFg"

[ Several |ines omtted]

" ¢ NAQEEBQADY YEAKY8x Yc 91 ESNe XZYTVx Es FA9t wZDpRj SKShDCcbut gPl COXcHUt "
"a2M FPsdgQogOl 8y1nEnlqgJi QUEGLt QUwWUx4GAv APz sWEs Ky Kk Zhgxr xkJUB39K"



"Pg57pPyt fInl QTgYi SrycCEVHIDvhk92X7K2cab3aVV1l+j Or KI R/ Sy6b4=***");
PCKeyedCard cardData = new PGKeyedCar d(car dNunber, expiration, cvv);
Bool ean i ncl udeCwW = true;

String encryptedCardData = pg.encrypt(cardbData, includeCw);

In this example, 'encryptedCardData’ would now contain a string that can be passed to the Payment Gateway in
place of credit card information. The parameter name to use when passing this value is 'encrypted_payment'.

For example, asimple DirectPost API string would ook something like this:

(This example assumes your Merchant server is running a PHP script that has received the encrypted card data
through a POST parameter called 'cardData.)

/1 Busi ness logic, validation, etc. Wen ready to process the paynent...
$cardData = $ _PCOST[' cardData'];

$post String = "usernane=denp&passwor d=1234&t ype=sal e&anount =1. 00&encr ypt ed_payne!
/| Post to Gat eway

We suggest using POST instead of GET to reduce the possibility of the data being kept in alog file. For more
information on how to communicate with the Payment Gateway, see the APl documentation.

Swipe Devices
Mobile APIl: Android

Per missions

Y ou will need to grant the application multiple permissions in order to use a swipe device. This can be done by
modifying the manifest file by adding:

<uses-perm ssi on androi d: nane="andr oi d. perm ssi on. RECORD_AUDI O' />

<uses-perm ssi on androi d: nane="andr oi d. per m ssi on. MOUNT_UNMOUNT_FI LESYSTEMS" [ >
<uses- permn ssi on androi d: nane="andr oi d. per m ssi on. WRI TE_EXTERNAL STORAGE" />
<uses- perm ssi on androi d: nane="andr oi d. per m ssi on. | NTERNET" />

In the class that intends to handle swipe events, add a PGSwipeController property called swipeController, and
then in your init function, initialize the object with this line:

/1 This exanple is for the i PS Encrypted Mbile Card Readersw peController = new |
If you want to change the default settings, you can change them now. Here are some examples:

swi peControl | er. get Devi ce().set Sw peTi neout (30) ;
swi peControl | er. get Devi ce() . set Al waysAccept Swi pe(fal se);
swi peControl | er. get Devi ce().setActi vat eReader OnConnect (f al se);

Y our class will have to implement the PGSwipeListener protocol. If you are only interested in knowing when a
card is swiped, you can safely leave every other event handler empty, as shown here (or add your own code to,
for example, display an image indicating that the swipe reader is ready for a swipe). In this example, when the
swipeisreceived, the card datais saved in a property (swipedCard) for eventual transmission to the Gateway



(not shown), and two TextView variables (cardNumberField and expirationField) are set to show the masked
card number and expiration date. If a bad swipe occurs, onSwipedCard is till called, but "card" will be null.

@verride
public void onDevi ceConnected(final PGSw peDevi ce device)

{

} .

@erride

Publ i ¢ voi d onDevi ceDi sconnected(final PGSw peDevi ce devi ce)

{

}
@verride
public void onDevi ceActivati onFi ni shed(final PGSw peDevi ce devi ce)

{

}
@verride
publ i c void onDevi ceDeacti vat ed(final PGSw peDevi ce devi ce)

{

}
@verride
public void onDevi ceReadyFor Swi pe(fi nal PGSw peDevi ce devi ce)

{

}

@verride

publ i c void onDevi ceUnr eadyFor Swi pe(fi nal PGSwi peDevi ce devi ce,
PGSwi peDevi ce. ReasonUnr eadyFor Swi pe reason)

{

}
@verride
public void onSw pedCard(final PGSw pedCard card, final PGSw peDevice device)

{
if (card !'= null)
this. runOnU Thr ead(new Runnabl e() {
public void run() {
Text Vi ew cardNunberField = (TextView)findViewByld(R id.cardNunber);
car dNunber Fi el d. set Text ( ( Char Sequence) car d. get MaskedCar dNunber () ) ;

}

} else {
/1A null card nmeans that there was a swi pe but it was unsuccessful.

Classes Overview
M obile API: Android

PGEnNcrypt

The PGEncrypt class contains all necessary to encrypt data to be sent to the payment gateway. Merchants
wanting to send transaction data to their servers before processing the transaction will want to use this method
in order to prevent their server from touching sensitive data.



e void setKey(String key)
This method takes in the public key and sets it to be used with the encrypt method.
e String encrypt(String plaintext)

This method accepts a string to be encrypted. Although any string can be passed, the Payment Gateway
will only pull fields related to credit cards from the encrypted text.

e String encrypt(PGCard card, boolean includeCVV)

Thisisthe preferred way of getting the encrypted card data. It will format and encrypt the card data for
you to pass on to the gateway.

PGSwipeDevice

This class represents the functionality that is common to the swipe reader devices. A PGSwipeDevice object is
passed along with every even generated by the devices in order to identify the device type and access device-
specific features by casting it to the specific swipe device.

o enum ReasonUnreadyForSwipe { DISCONNECTED, TIMED_OUT, CANCELED, REFRESHING,
SWIPE_DONE }

Used to explain why the device can no longer accept a swipe.
e enum SwipeDevice{ UNIMAG, IPS}

Used to identify the type of device being used.
¢ boolean getlsConneced()

Returns true if the swipe device is connected.
¢ boolean getlsActivated()

Returns true if the swipe deviceis activated.
¢ boolean getl sReadyForSwipe()

Returnstrueif the swipe device isready.
e SwipeDevice getDeviceType()

Returns the current device type.
e void setListener(SwipeListener value)

Sets the event listener.

¢ boolean setSwipeTimeout(int seconds)



Sets the timeout interval for the swipe device.

void setAlwaysA cceptSwipe(boolean alwaysA cceptSwipe)

True by default, if thisis set to false, a swipe must be requested once the device is ready.

void setActivateReaderOnConnect(bool ean activateReaderOnConnect)

True by default, if thisisto false, the device must be activated before it can be used.

boolean requestSwipe()

Notifies the reader to start waiting for a swipe. The device must be active before this can be called.
void cancel SwipeRequest()

Cancels a swipe request.

void stopSwipeController()

Cancels the current swipe request, unregisters the swipe device, and frees resources. Will not receive any
information from the device until it is resumed.

void restartSwipeController()
Registers the swipe device. Should only be called after calling stopSwipeController()
String getDefaultM sg()

Returns the default message for the current device state.

PGSwipel PS extends PGSwipeDevice

This class handles communications with the iPS Encrypted Mobile Card Reader.

¢ void InitializeReader(Context ctx)

This classis not intended to be instantiated directly. Instantiate a PGSwipeController instead. The
PGSwipeController will create a PGSwipel PS instance to interact with the IPS device.

PGSwipeUniM ag extends PGSwipeDevice

This class handles communication with the IDTECH Unimag device.

¢ void InitializeReader(Context ctw)

This classis not intended to be instantiated directly. Instantiate a PGSwipeController instead. The
PGSwipeController will create an instance of PGSwipeUniMag to interact with the Shuttle device.



¢ void updateCompatableDevicelL ist()

The UNIMAG device uses an xml compatibility list that consists of specific device settings that are
unigue to every device. This function should be called to handle new devices.

PGCard

Thisisasimple base class for the different types of cards that can be used. Thereis no reason to ever explicitly
declarethis.

e void setCVV (String CVV)
Setsthe CVV for the credit card data.
e String getCVV()
Returns the CVV for the card.
e String getDirectPostString(boolean includeCVV)

Returns a query string consisting of the card data that can be passed to the Payment Gateway through the
Direct Post API.

PGKeyedCard extends PGCard

This class should be used when accepting credit card information from a keyboard.
e PGKeyedCard(String ccnumber, String expiration, String cvv)
The standard constructor for this class. It should be used most of the time.
e PGKeyedCard(String ccnumber, String expiration, String cvv, String startDate, String issueNum)
This constructor accepts two more values that would be used for Maestro cards.
¢ void setCardNumber(String value)
Sets the card number to be used for the current card.
e void setExpirationDate(String value)
Sets the expiration date to be used for the current card.
¢ void setCardStartDate(String value)
Sets the start date for the current card.

¢ void setCardlssueNumber(String value)



Sets the issue number for the current card.
String getCardNumber()

Returns the current card number.

String getExpirationDate()

Returns the current expiration date.

String getCardStartDate()

Returns the current start date.

String getCardlssueNumber()

Returns the current issue number.

PGSwipedCard extends PGCard

This class should only be used along with an unencrypted swipe device.

PGSwipedCard(String trackl, String track2, String track3, String cvv)
The constructor that sets the card data accordingly.
void setTrack1(String value)

Sets track1 for the current card.

void setTrack2(String value)

Sets track?2 for the current card.

void setTrack3(String value)

Sets track3 for the current card.

void setMaskedCardNumber(String value)

Sets the masked card number for the current card.
void setCardholderName(String value)

Sets the name on the current card.

void setExpirationDate(String value)

Sets the expiration date for the current card.

String getTrack1()



Returns the track1 data.
e String getTrack2()
Returns the track2 data.
e String getTrack3()
Returns the track3 data
e String getMaskedCardNumber()
Returns the masked card number. This should be used when trying to display card information to the user.
e String getCardholderName()
Returns the name on the card.
e String getExpirationDate()

Returns the expiration date.

PGEncryptedSwipedCard extends PGSwipedCard

This class should be used for all encrypted swipe devices.
e PGEnNcryptedSwipedCard(String trackl, String track2, String track3, String ksn, String cvv)
The constructor accepts al class variables.
¢ void setksn(String value)
Sets the KSN that is used to decrypt the card information at the gateway.
e String getKsn()

Returns the KSN.

PGSwipeController

The PGSwipeController classis used to maintain the swipe device.
e PGSwipeController(Object source, PGSwipeDevice.SwipeDevice deviceType)
This constructor sets the type of deviceto be used and initializesit.

e PGSwipeDevice getDevice()



Returns the device that is currently initialized. Only one should beinitialized at atime.
e PGSwipeUniMag getUnimag()

Can be used instead of getDevice, will produce the same result aslong asa UNIMAG deviceis being
used.

o PGSwipel PS getlPS()

Can be used instead of getDevice, will produce the same result as long as an IPS device is being used'.

PGSwipeController .SwipeL istener

Thisinterface must be implemented in order to receive events from the card readers
¢ void onSwipedCard(PGSwipedCard card, PGSwipeDevice swipeDevice)
Method called when a card is swiped. It accepts the card data and the device used.
¢ void onDeviceReadyForSwipe(PGSwipeDevice swipeDevice)
Called when the device is ready to read a swipe.

¢ void onDeviceUnreadyForSwipe(PGSwipeDevice swipeDevice,
PGSwipeDevice.ReasonUnreadyFor Swipe reason)

I's called when the device can no longer read a card. It is passed the device and the reason it can no longer
accept aswipe.

¢ void onDeviceConnected(PGSwipeDevice swipeDevice)
This method is called when the swipe device is connected.
¢ void onDeviceDisconnected(PGSwipeDevice swipeDevice)
This method is called when the swipe device is unplugged from the android device.
¢ void onDeviceA ctivationFinished(PGSwipeDevice swipeDevice)
This method is called when a swipe can be requested.
¢ void onDeviceDeactivated(PGSwipeDevice swipeDevice)

This method is called when the device is stopped. Once thisis called, the device hasto be restarted to
function again.



Usingthe Library
Mobile API: 10S

Creating a Proj ect

The fastest way to get started is to check out the PaymentGatewayEncryptionExample and
PaymentGateway SwipeExample projects that can be downloaded from the Payment Gateway's I ntegration
section. If you prefer to create your own project instead, use these steps (current as of Xcode 5.0):

1. Download the Mobile API .zip file from the Integration Portal by using the "Downloads" link under the
Mobile API section. Thisfile contains both the iOS and Android libraries.

2. Create anew Xcode Project.

3. Copy thefilesinthe .zip fileinto your project folder, and add them to your Xcode project. The files you
will need are PGMobileSDK .a and the entire folder PGMobileSDK containing the headers. These are
found in the .zip file under AppleiOS -> Payment Gateway SDK.

4. Under the project's Build Phases settings, add these libraries to the Link Binary With Libraries section:

o AudioToolbox.framework

o AVFoundation.framework

o External Accessory.framework

o MediaPlayer.framework
Security.framework

o libstdc++.6.0.9.dylib

5. (Optiona - see note below) - In your Info.plist, add arow for "Supported external accessory protocols’,
and add "com.gatewayprocessingservices.iprocess' as Item 0. This enables connection to the iDynamo
swipe reader.

(0]

Note: You may wish to skip step 5 if you do not need to support the iDynamo. Apple requires manufacturers of
accessories that use the dock connector to add your app to their product plan before approving your app for the
app store. You will need to contact MagTek in order to have your app added to their product plan. Contact
MagTek for more details.

Viewing documentation in Xcode

Adding the doc set to X code allows the most up-to-date, relevant documentation to appear in the IDE as you
type. To enable access to the SDK documentation from inside X code:

Under the X code menu, click Preferences

Navigate to the Downloads page

On the Documentation tab, click Add.

On the "Enter adoc set feed URL" window that pops up, enter:

https:.//secure.saf ewebservices.com/merchants/resources/integration/docset/iOSSDK .atom
Click Add

Click the newly-added install button

el A

o U



|mportant Info About the App Store

The Apple App Store's current policy is to require mobile apps to purchase digital goods (e.g. downloadable
content, etc.) through the App Store. For that reason, this SDK isintended only for use in apps selling real-
world goods and services. Please direct questions about Apple's App Store policiesto Apple. Their policies are
subject to change at their discretion.

End-to-End Encryption
Mobile API: 10S

Acquiring a Public Key

a
After logging into the Payment Gateway, navigate to Settings->Security Keys->View Mobile SDK Key.

Y ou can click on the Objective-C example link to get aversion that can easily be copied and pasted into
your project.

Use the Query API. In order to get the public key, you will need to use 'report_type=sdk_key'. The key
will be returned in the &It;sdk_key& gt; tag.

Encryptinga Card

#i nport " PGEncrypt. h"
#i nport "PGCards. h"
PCGEncrypt encryption = [[PGEncrypt alloc] init];
[encryption setKey:
@***999| M | EEj CCA3ugAW BAgl BADANBgkghki GOWOBAQQFADCBY TEL MAK GA1UEBh"
" MCVWMKETAPBgNVBAgTCEI sbd ub2l zMRMAVEQYDVQQHEWP TY2hhdWLi d XJInMRgwig*™
[ Several |ines omtted]
" cNAQEEBQADg YEAKY8X YC91ESNe XZYTVXEsFA9t wZDpRj SKShDCchbut gPl COXcHU ™
"a2M FPsdgQoqgOl 8y1nEnlqJi QUEGLt 9UMIXx4GAV APz sWEs Ky KQkZhgxr xkJUB39K"
"Pg57pPyt fInl QTgYi Sr ycCEVHIDvhk92X7K2cab3aVWW1+j Or KI R/ Sy6b4=***"];
PGCard *cardData = [[ PGKeyedCard alloc] initWthCardNunber: cardNunber Fi el d. t ext
expi rationDat e: expirationField.text
cvv:cvvField.text];

NSString *encryptedCardData = [encryption encrypt: cardData includeCvV: NQ ;

encryptedCardData will contain a string that can be passed to the Payment Gateway in place of credit card
information. The parameter name to use when passing this value through DirectPost is "encrypted _payment”.
For example, asimple DirectPost API string would look something like this:

(This example assumes your Merchant server is running a PHP script that has received the encrypted card data
through a POST parameter called 'cardData.)

/I Busi ness logic, validation, etc. Wen ready to process the paynent...
$cardData = $ POST[' cardData'];
$post String = "user nane=denp&passwor d=1234&t ype=sal e&anount =1. 00&encr ypt ed_paynel



/| Post to Gat eway

For more information on how to communicate with the Payment Gateway, see the API documentation.

Swipe Devices
Mobile API: 10S

Creating the Controller

In the class that intends to handle swipe events, create a PGSwipeController object in your init method.
Initialize the object with thisline to support Shuttle readers:

swi peController = [[ PGSwi peControl |l er alloc] initWthDel egate: self audi oReader: Al
or for the IPS Encrypted Card Reader:
swi peController = [[ PGSwi peControl |l er alloc] initWthDel egate: self audi oReader: Al

Only asingle model of audio jack-connected reader can be enabled at atime. The audioReader parameter allows
you to choose which type, UniMag (Shuttle) or 1PS Encrypted Card Reader, you want to allow. See the
PGSwipeController's initWithDel egate:audioReader: documentation for more details.

Y our class will have to implement the PGSwipeDelegate protocol. If you are only interested in knowing when a
card is swiped, you can safely leave every other event handler empty, as shown here (or add your own code to,
for example, display an image indicating that the swipe reader is ready for a swipe). In this example, when the
swipeisreceived, the card datais saved in a property (swipedCard) for eventual transmission to the Gateway
(not shown), and two Ul TextField properties (cardNumberField and expirationField) are set to show the masked
card number and expiration date.

If abad swipe occurs, didSwipeCard:device: may still be called, but "card" will be nil. An error messageis
displayed in this example. Note: Not al card reader models give feedback when a bad swipe is received.

- (voi d) devi ceConnect ed: ( PGSw peDevi ce *)sender

- (voi d) devi ceDi sconnect ed: (PGSwi peDevi ce *)sender

- (voi d) devi ceActi vati onFi ni shed: (PGSw peDevi ce *)sender result: (Sw peActivationR
b . . . .

- (voi d) devi ceDeact i vat ed: (PGSw peDevi ce *)sender

b . . . .

- (voi d) devi ceBecaneReadyFor Swi pe: ( PGSwi peDevi ce *)sender

- (voi d) devi ceBecaneUnr eadyFor Swi pe: (PGSw peDevi ce *)sender reason: (Sw peReasonUn

{
}



-(voi d)di dSwi peCard: (PGSw pedCard *)card devi ce: (PGSw peDevi ce *)sender

if (card !'=nil) {
swi pedCard = [card retain];
car dNunber Fi el d. t ext = card. maskedCar dNunber ;
expi rationFi el d. t ext card. expirati onDat e;
} else {
/1A nil card neans that there was a swi pe but it was unsuccessful.
U A ertView *alert = [[U A ertViewalloc] inttWthTitle: @Sw pe Error”
nmessage: @ The reader was
del egate: ni |
cancel ButtonTitl e: @ OK"
otherButtonTitles:nil];

[al ert show;
[al ert rel ease];

}
Supported Devices

IPS Encrypted Card Reader

The IPS is an audio jack-connected card reader. Unlike the IDTECH Shuittle, the IPS is powered by an internal
battery. The IPS has a fast startup time and does not produce a constant tone through the audio jack.

Because the I PS connects through the audio port and there is no way to immediately detect the device type, you
will receive a deviceConnected: event even if the user has only plugged in headphones. Since thereis no
activation with the IPS, a deviceActivated: and deviceBecameReadyForSwipe: will also be sent immediately. In
order to be sure that the device is an | PS reader, the PGSwipel ps provides a beginTestCommunication: method
you can use to attempt to communicate with the device. If it returns success, the device isan IPS reader. Thisis
not done by default to eliminate a delay before the device becomes active.

IDTECH Shuttle

The Shuttle (referred to in code as a UniMag device) is an audio jack-connected card reader. It is powered by a
tone from the iPod / iPad / mobile phone. Before the Shuttle can receive swipes, it must be powered up.

Because the Shuttle connects through the audio port and there is no way to detect the device type until the
deviceis activated, you will receive deviceConnected events whenever any device is attached to that port. For
example, if the user attaches headphones, you will receive a connection event from the Mobile SDK.

The Mobile SDK can be configured to automatically attempt to power on the swipe reader immediately (thisis
the default), or you can disable the automatic activation and only activate the device when desired (e.g. on a
payment screen, or when the user clicks a button).

Important: When powering on the device, the audio volume must be at maximum (done automatically by
default). The tone generated through the audio port to activate the device can be very painful to alistener if they
have connected speakers or headphones. For this reason,

swipeController.uniM agReader.messageOpti ons.acti vateReaderWithoutPromptingUser is set to NO by default,
causing the SDK to prompt the user for confirmation before activating the reader.



The Shuttle saves battery by only alowing swipes when a swipe has been requested, and a timeout occurs if a
swipe is not received quickly enough (20 seconds by default). For simplicity, the SDK defaults to automatically
requesting a swipe on activation and continuously renewing the swipe request. If you have issues with battery
life, you can set swipeController.uniMagReader.alwaysA cceptSwipe to NO and manually call
[swipeController.uniMagReader requestSwipe] when ready for a swipe.

iDynamo

The iDynamo connects to the mobile device via Apple's dock connector and is only compatible with iOS
devices that use the older 30-pin (non-Lightning) dock connector.

When physically attached, the iDynamo is ailmost immediately ready to receive swipe events. When connected,
the Swipe Delegate should expect a deviceConnected: message, immediately followed by a
deviceA ctivationFinished: message, then a deviceBecameReadyForSwipe: message.

When the device is physically detached, the delegate receives the eventsin reverse order, i.e.
deviceBecameUnreadyForSwipe:, deviceDeactivated:, deviceDisconnected..

App Store: To support the iDynamo on an app distributed through the App Store, Apple may require you to
contact MagTek for information before they will process your submission. To disable iDynamo support, do not
add it to " Supported external accessory protocols' in your info.plist. You will still receive connect and
disconnect events, but activation will fail, so be sure to check if the sending device is the iDynamo object and
ignoreit if so.

Known Issue with the iDynamo: There is an issue with device disconnection with the iDynamo and iOS's
External Accessory framework. Upon disconnection, the stream communicating with the device is closed, during
which you may receive the warning: [ NSCondition dealloc]: condition (<NSCondition: 0x1d54ce90> '(null)’)
deallocated while still in use. After reconnecting, alater disconnect may randomly cause the app to crash with
an attempt to send a message to the deallocated instance. This does not occur frequently, and is more likely to
occur when rapidly opening and closing the application (which sends a disconnect followed by a reconnect
when the app re-opens). Thisissue iswith Apple's accessory-handling framework. Apple is aware of the issue
and may fix it in afuture iOS release.

Classes Overview
Mobile API: 10S

PGSwipeController

The PGSwipeController contains a set of swipe reader classes that control individual swipe readers. Thisisthe
main Mobile Swipe SDK class required for using swipe devices, intended to be instantiated near the app's
startup. The delegate you set on the PGSwipeController is the object that will receive all of the SDK's swipe
events.

Through this class, you can access the controller classes for individual swipe device types (PGSwipel ps
*ipsReader, PGSwipel Dynamo *iDynamoReader, and PGSwipeUniMag * uniMagReader).



Y ou should be sure to call initWithDelegate rather than the parameterlessinit because during initialization a
check is made to see if any devices are already connected and sends a deviceConnected event if they are. If the
parameterlessinit is used, the initial connection message will be missed.

e -(id)initWithDel egate: (id<PGSwipeDel egate>)del egate audioReader: (A udioJackReader Type)reader Type

Initializes the PGSwipeController and the individual swipe reader classes. Init checksif any devices are
connected and sends a deviceConnected event if they are, so initWithDelegate: should always be used
rather than init to ensure that a connection event is received if the device is already connected.

The audioReader: parameter selects which type of audio jack-connected card reader to enable. Only one
type of audio jack-connected reader can be used at atime to prevent more than one device library from
attempting to access the audio system at the same time. AudioJackReaderUnimag enables the Shuttle
library, and AudioJackReaderlps enables the IPS Encrypted Card Reader library. Y ou may also select
AudioJackReaderNone to disable both libraries, or AudioJackReaderA utodetectOnConnect to allow the
SDK to attempt to determine the type on connection. Autodetection has several drawbacks. See
PGSwipeController beginAutodetectA udioJackCardReader for more information.

¢ -(void)setAudioJackReader Type: (AudioJackReader Type)audioJackReader Type
messageOpti ons: (PGSwipeUni M agM essageOptions * )messageOptions

Sets the enabled audioJackReader Type. This can be used to enable support for either the IPS Encrypted
Card Reader or the UniMag (Shuttle) reader. Since the underlying libraries may not always unload
cleanly, you should avoid calling this repeatedly to change the supported device type. Doing so could
cause the reader to malfunction or be damaged. Setting this to AudioJackReaderA utodetectOnConnect
will disable any currently selected audioJackReader Type and autodetect upon device connection.

messageOptions will be used only when audioJackReader Type is AudioJackReaderUnimag to replace the
default message options. For any other AudioJackReaderType, or to use the default message options for
AudioJackReaderUnimag, this should be nil.

¢ -(void)beginAutodetectAudioJackCardReader;
Asynchronously attempts to detect the card reader type currently attached to the audio jack.

A communication test isfirst attempted for an IPS reader. If that fails, an attempt is made to power up a
UniMag (Shuttle) card reader. If either test succeeds, the audioJackReaderType is set to the correct value,
and the device will be made ready for use. The result of the autodetect is reported to the delegate through
deviceAutodetectCompl ete:.

Note: Both the IPS communication test and the UniMag power up produce very loud tones through the
audio jack. If speakers or headphones are attached, the tones would be unpleasant to the user. It is
recommended that the user be warned and alowed to remove headphones before calling this function.
This library suppresses user notifications from the UniMag reader during autodetect.



Because the device is powered up in order to test it, you will not receive connection / activation / ready
for swipe events during detection. When your delegate receives its deviceAutodetectCompl ete message,
check the isConnected, isActive, and isReadyForSwipe properties for its current state and to complete any
initialization.<

In order to detect the devices, all of the underlying card reader libraries must be loaded. Under some
circumstances, these libraries may not unload cleanly, resulting in unreliable use of the card reader.
Autodetect is also avery slow process. For these reasons, you should not rely on autodetection for each
use of the app.

Because communication through the audio jack is not always perfect, autodetect does not always return a
correct result. The most common failure typeis returning CardReader A utodetectResultFail even though a
supported device is connected.

If it is known in advance which card reader type will be used, that type should be specified when
initializing the PGSwipeController. If multiple devices must be supported, it is strongly recommended
that the result of the autodetect be saved (e.g. in NSUserDefaults) and re-used on app startup.

PGSwipeDevice

The PGSwipeDevice class represents the functionality that is common to the swipe reader devices.
PGSwipel Dynamo and PGSwipeUniMag both use PGSwipeDevice as a base class.

A PGSwipeDevice object is passed along with every event generated by the swipe devicesto allow you to
identify the device type and access device-specific features by casting to the specific swipe type.

bool isConnected

True when the reader is physically attached to the device.

bool isActivated

True when the reader is powered up / initialized.

bool isReadyForSwipe

True when the reader is able to accept card swipes from the user.
id<PGSwipeDel egate>del egate

Sets the delegate that will receive the device's events. Y ou should not set the delegate directly. Setting the
delegate on the PGSwipeController sets the delegate for each of its members.

PGSwipeDelegate

The PGSwipeDel egate protocol must be implemented by the class that intends to receive swipe reader events.
The following event handlers will need to be implemented.



e -(void)didSwipeCard:(PGSwipedCard *)card device:(PGSwipeDevice *)sender

This event is sent whenever the user swipes acard. Normally "card" will be either a
PGEnNcryptedSwipedCard or PGM agnesafeSwipedCard (depending on the swipe reader) with track data,
masked card number, expiration date, and cardholder name. If the swiped card cannot be read, "card" will
be nil.

¢ -(void)deviceBecameReadyForSwipe:(PGSwipeDevice * )sender

This event is sent when isReadyForSwipe becomes true. Between this event and the receipt of
deviceBecameUnreadyForSwipe, any swipe should produce a didSwipeCard event.

¢ -(void)deviceBecameUnreadyForSwipe:(PGSwipeDevice *)sender
reason: (SwipeReasonUnreadyFor Swipe)reason

This event is sent when isReadyForSwipe becomes false. There are many reasons the reader could
become unready to receive swipe events, e.g. the swipe request times out, the device is disconnected, etc.
Check the value of "reason" to determine the cause.

On Shuttle readers, if you have set the device to awaysAcceptSwipe, the reason may be set to
SwipeReasonUnreadyForSwipeRefreshing. In that case, there is no need to request a new swipe. The
"unready” state is momentary while the device automatically renews after a timeout, swipe, or other event.

¢ -(void)deviceConnected:(PGSwipeDevice * )sender;

Occurs when the reader is physically connected to the device. With audio-port connected devices like the
Shuttle, this event can be sent when the user attaches headphones. See the PGSwipeUniMag
documentation for more information.

¢ -(void)deviceDisconnected:(PGSwipeDevice * )sender;

Occurs when the reader is physically disconnected from the device. With audio-port connected devices
like the Shuttle, this event can be sent when the user detaches headphones. See the PGSwipeUniMag
documentation for more information.

¢ -(void)deviceActivationFinished:(PGSwipeDevice *)sender result:(SwipeActivationResult)result;

Occurs when the device has finished an attempt to power up/initialize. This may occur at the same time as
deviceConnected or later, depending on the device and settings. See the individual device documentation
for specifics.

Receiving this event does not mean the initialization succeeded. Be sure to check the value of "result” to
verify that it is SwipeA ctivationResultSuccess.

e -(void)deviceDeactivated:(PGSwipeDevice *)sender;

Occurs when the device has powered down. This may occur when the device is disconnected or, for
certain swipe readers, when you make a call to power down the device.

e -(void)deviceAutodetectStarted,



Occurs when an attempt to detect the type of an audio jack-connected card reader has started. This can be
triggered by amanual call to PGSwipeController beginAutodetectAudioJackCardReader or automatically
when the PGSwipeController isin AudioReaderAutodetectOnConnect mode and an object is attached to
the audio jack by the user.

¢ -(void)deviceA utodetectCompl ete: (CardReader A utodetectResul t)result;

Occurs when an attempt to detect the type of an audio jack-connected card reader has finished. The result
may be CardReaderA utodetectResultUniMag, CardReader A utodetectResultlps, or
CardReaderAutodetectResultFail if the type could not be determined.

When this message is received, the PGSwipeController's audioJackReader Type will have been set to the
appropriate value and the card reader will be activated. Since the device is powered up while
autodetecting, no events for connection, activation, or readyForSwipe will be received. Check the
isConnected, isActivated, and isReadyForSwipe properties to determine the device's state.

PGSwipel Dynamo

This classis the interface to the iDynamo reader. It is not intended to be instantiated directly. Instantiate a
PGSwipeController instead. The PGSwipeController will create a PGSwipel Dynamo instance to interact with
the iDynamo device.

The iDynamo has no configurable options. When the device is attached, it is active and ready for swipe. The
only property for the PGSwipel Dynamo class is a delegate to receive events, which should not be set directly.
When the delegate is set for the PGSwipeController, the same delegate is passed to the PGSwipel Dynamo
instance it contains.

PGSwipeUniMag

This classistheinterface to the IDTECH Shuttle reader. It is not intended to be instantiated directly. Instantiate
a PGSwipeController instead. The PGSwipeController will create a PGSwipeUniMag instance to interact with
the Shuttle device.

There are several flags and methods available for the Shuttle. For an app that does not need much specific
control of the swipe device and is mostly interested in the swipe event, the defaults can be kept and the device
will power up and become ready for swipe when attached.

e id delegate;

Gets or sets the delegate that will receive events. Y ou should not set this directly. When the
PGSwipeController's delegate is set, it will passit through to this delegate.

e PGSwipeUniMagM essageOptions * messageOptions,



Contains a set of options for interactions with the user, e.g. whether to prompt before powering up the
Shuttle and the text of error messages. See the PGSwipeUniMagM essageOptions section for specific
settings.

BOOL activateReaderOnAttach;

If thisistrue, the SDK will attempt to power-up the reader when attachment is detected. There are 3
things to be aware of:

1. If the user attaches headphones to the mobile device, it will be treated as a swipe reader and an
attempt to power it up will be made.

2. Before the attempt to activate the reader, if messageOptions.activateReaderWithoutPromptingUser
isset to false (it isfalse by default), the user will receive a prompt asking to confirm activation. If
they decline, no activation will be attempted.

3. If you call powerDown to deactivate the device, leaving activateReaderOnAttach set to true will
cause the device to immediately power back up.

BOOL automaticallySetVolumeToMaxOnActivate,

If thisis set to true, the device's volume will be set to maximum immediately before any attempt to power
on the reader. Since the reader requires full volume to activate, this defaults to true and should normally
remain true.

BOOL awaysAcceptSwipe;

The Shuttle does not accept swipes from the user unless a swipe has been requested. If
alwaysAcceptSwipe istrue, the SDK will immediately request a swipe and renew the request any time the
old swipe request times out or ends. Y ou will still receive periodic didBecomeUnreadyForSwipe:
messages, but the reason will be SwipeReasonUnreadyForSwipeRefreshing to indicate that you should be
receiving a didBecomeReadyForSwipe: message immediately after without any interaction.

The mobile device's battery may deplete faster if the swipe reader is aways awaiting a swipe. If battery
lifeisaconcern, consider setting this to false and using requestSwipe when a swipe is expected, or only
setting alwaysA cceptSwipe to true when a swipe is expected.

If alwaysAcceptSwipeistrue, you should not use requestSwipe or cancel SwipeRequest. By defaullt,
alwaysAcceptSwipeistrue.

-(void)powerUpDevice:(BOOL )powerUp;

Powers up the reader if powerUp istrue or cancels a power up if powerUp isfalse. If
activateReaderOnAttach istrue, thisis called automatically after connection to power up the device. If
you wish to only power up the device after user interaction, you should wait until a deviceConnected:
event isreceived, then call powerUpDevice:Y ES when they choose to power up. This should only be used
if activateReaderOnAttach isfalse.

-(void)powerDown;

Powers down the reader. This may extend mobile device battery life. A deviceConnected event will be
received after shut-down, which will trigger a power-up if activateReaderOnAttach istrue, so be sureto



set activateReaderOnAttach to fal se before powering down. It is not necessary to power down the reader
before disconnecting it from the device.

e -(void)requestSwipe;

Starts listening for swipe events. Y ou will never need to call thisif you set alwaysAcceptSwipe to true (it
istrue by default). After receipt of a didBecomeUnreadyForSwipe message, you may request a new swipe
(unless the reason is SwipeUnreadyFor SwipeReasonRefreshing). The request will timeout after 20
seconds, or the amount of time you set in setSwipeTimeoutDuration:.

e -(void)cancel SwipeRequest;

Cancels a swipe request to stop listening for swipe events. Y ou should not use thisif you did not
manually start the swipe request with a call to requestSwipe.

¢ -(void)setSwipeTimeoutDuration:(int)seconds,

Sets the time between requestSwipe and when swipes will no longer be accepted. Default and maximum
are 20 seconds. The minimum is 3 seconds. This still applies even if alwaysAcceptSwipe istrue, but the
swipe request will be automatically renewed in that case.

PG SwipeUniM agM essageOptions
This class contains a set of user-interaction options for the Shuttle device.

e BOOL activateReaderWithoutPromptingUser;

If thisis set to true (false by default), the reader is activated automatically immediately after you receive a
deviceConnected: event. If thisisfalse, you will need to call powerUpDevice: during or after the
deviceConnected event to power the device or cancel powering up.

e BOOL showlnitializingReaderM essage;

If true, an "Initializing Card Reader..." aert is shown while the reader powers up and is dismissed once
power-up completes.

e NSString * cardReaderA ctivationPrompt;

Gets or sets the prompt that will be displayed to confirm that the user would like to power up the reader.
If you change this prompt, you should also change cardReaderA ctivationAtMaxV olumePrompt. Note: an
activation prompt is only shown before activation if
messageOptions.activateReaderWithoutPromptingUser isfalse. This message is meant to include a
warning to indicate that the volume will be set to max. If automaticallySetVolumeToMaxOnActivateis
false, cardReaderActivationAtMaxV olumePrompt is shown instead of this.

e NSString * cardReaderA ctivationAtMaxV olumePrompt;

Gets or sets the prompt that will be displayed to confirm that the user would like to power up the reader.
If you change this prompt, you should also change cardReaderA ctivationPrompt. Note: an activation



prompt is only shown before activation if messageOptions.activateReaderWithoutPromptingUser is false.
If automaticallySetVolumeToMaxOnActivate is true and the volume is not at maximum,
cardReaderActivationPrompt is shown instead of this.

e NSString * cardReader TimeoutM essage;

Gets or setsthe aert that is shown if the reader times out while attempting to power up. If you prefer to
handle this differently, set this message to nil to prevent it from being shown, then handle the
activationDidComplete:result: message with aresult of SwipeA ctivationResultTimeout.

e NSString * volumeTooL owM essage;
PGSwipel ps

This classis the interface to the |PS Encrypted Card Reader. It is not intended to be instantiated directly.
Instantiate a PGSwipeController instead. The PGSwipeController will create a PGSwipel ps instance to interact
with the IPS device.

e id delegate;

Gets or sets the delegate that will receive events. Y ou should not set this directly. When the
PGSwipeController's delegate is set, it will passit through to this delegate.

e -(void)shutdown;

Closes the card reader's connections and disables event handling to allow it to be deallocated. Y ou should
not call thisdirectly. It is called by the PGSwipeController when necessary.

¢ -(void)beginTestCommunication(id)communicationTestDel egate;

Asynchronously sends a communication test message to the card reader device and waits for a response.
This can be used to detect whether the connected device is an IPS Encrypted Card Reader. A messageis
sent viathe audio jack and if no response is received from the device within 5 seconds, the attached object
isassumed not to be an IPS reader. Note that calling this will produce a short, loud tone through the audio
jack if headphones are attached.

The result isreturned to the communcationTestDel egate by calling
ipsCommunicationTestCompl eteWithResult:(BOOL )succes with success set to YES or NO, depending on
if aresponse was sent by the device.



